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[bookmark: _Toc14272064]Goal of this guide
This guide serves as an introduction to accessible documents. The content provides a basic understanding of how to make PDF documents accessible using Adobe Acrobat Pro.
The information applies to information communicated in reports, advertising, signage, program guides, infographics and websites. Note: Adobe Acrobat Pro DC was used as the software of reference in creating the instructions and screen shots for this guide. Other versions of Adobe Acrobat Pro (Pro versions 11 or greater) or Foxit Phantom will have functions and features to create accessible documents, but the interface may be different depending on the version. Adobe Reader is not sufficient to make documents accessible. 
[bookmark: _Toc14272065]What is an accessible document?
The term “accessibility” can be applied to a range of issues and topics; in this context, we are referring to creating accessible documents, which meet the needs of people with different disabilities including those with visual, learning and cognitive disabilities. Some of these individuals will use assistive technology to access information such as devices that magnify text, read the text aloud or allow the person to adapt the appearance of text (i.e. colour and contrast changes). We need to make documents that allow for use of these technologies or other strategies that individuals may use to access information. 
[bookmark: _Toc14272066]Why create accessible documents?
Improving accessibility (of documents, facilities, etc.) promotes inclusion, dignity and equal access to opportunities. 
In Ontario, we also have a legislated obligation to provide access to information, through the accessible format provisions of the Accessibility for Ontarians with Disabilities Act (AODA). The Information and Communications Standard of the AODA requires us to provide accessible formats and communication supports, upon request. As an educational institution, Trent also has obligations to provide educational material in an accessible format, upon request; this includes accessible formats of student records, program information, and materials used for educational purposes. There are specific obligations for libraries of educational institutions to provide print as well as digital and multimedia resources in an accessible format when requested, with some exceptions. Also, under the AODA Information and Communications Standard are requirements for websites and web content; this includes documents on the web. 
The Ontario Human Rights Code also requires that Trent accommodate disability-related needs including those relevant to education, housing and employment. 
[bookmark: _Toc520194274][bookmark: _Toc14272067]Do all documents posted on Trent’s website need to be accessible? 
All new websites and web content including documents posted to the external (public-facing) website must meet Web Content Accessibility Guidelines (WCAG) 2.0 Level A criteria. As of January 1, 2021, all websites and web content that have been posted after January 1, 2012 need to meet WCAG 2.0 Level AA criteria. There are exceptions in the AODA made for captioning of live-streamed content and for audio description of pre-recorded content.  
[bookmark: _Toc14272068]
Accessible Document Compliance
There are various standards for accessible documents.
Offline information (information not posted to any of Trent’s websites)
Trent University will provide offline information in an accessible format upon request, in a timely manner, and at a cost no more than the regular price. 
Online information (information posted to a Trent official website)
Online information will generally be available on Trent’s website in HTML format. Where online information is more suitable in a document format, the information will be available as a PDF or Microsoft Word document.
The requirements for PDF document accessibility are found in the PDF Techniques for WCAG 2.0 (URL: http://www.w3.org /TR/WCAG20-TECHS/pdf).
Many of the same requirements that apply to general document accessibility such as sufficient font size and contrast, meaningful hyperlinks and alternative text, also apply to PDF documents. This guide will focus specifically on PDF-related requirements. 

[bookmark: _Toc14263209][bookmark: _Toc14272069]Converting from Microsoft Word to PDF
Use the Acrobat tab when converting to PDF.
Documents converted from Microsoft (MS) Word to PDF should utilize the Acrobat tab on the main ribbon with MS Word. 
Acrobat Tab
Use the following steps to place the Acrobat tab on the main ribbon.
1. In the File > Info tab select Options from the left-side menu. The Options window will appear. 
2. Select Customize Ribbon. 
3. In the Customize Ribbon menu on the right side ensure that Main Tabs is selected in the first drop-down box. 
4. Look for Acrobat in the list provided and ensure that there is a check mark in the box. 
5. To exit window, press OK. 
Conversion 
Documents are often best converted using the Preferences option in the Acrobat tab of MS Word. See screen shot. 
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In the Acrobat PDFMaker window within Preferences ensure that the following Application Settings boxes are checked:
· Create Bookmarks.
· Add Links.
· Enable Accessibility and Reflow with tagged Adobe PDF. 
Selecting these options will allow links, bookmarks and tags to be created in the PDF using the structure and existing elements of the MS Word document. See screen shot: [image: ]
Advanced Settings
Embed Fonts
A key aspect of accessibility is embedded fonts. Embedded fonts are those that are within the document. This ensures that documents opened on another device, or by another user will have the intended fonts and there will be no font substitutions which could result in inaccessible or distorted/illegible font types or symbols. Fonts can be embedded in a PDF during the conversion from MS Word by taking the following steps: 
1. In the Preferences PDFMaker window select Advanced Settings.
2. Select the Fonts option on the left-side of the window. 
3. In the Fonts tab, remove all fonts from the Never Embed box, using the Remove button below the box. 
4. At the top of the Fonts window, ensure the Embed all fonts option is checked. See screen shot. 
[image: ]
Images 
Within the Images tab of the Advanced Settings, the first two options refer to colour and grayscale images. 
Within these two options:
· Set the pixels per inch to at least 150. The third option, monochrome, will already be set to well beyond 150. This will aid in image resolution when the user is “zooming in” on an image or using magnification tools. 
· In the colour and greyscale options set the Image Quality to maximum,
·  Ensure the compression setting, Automatic (JPEG), is maintained. See screen shot. 
[image: ]
Saving a Conversion Setting 
Save this as an accessible conversion setting so that the edits made are saved and ready for next time.
1. Click Save As and go to Local C Drive.
2. Select Users and choose your user name.
3. Then go to App Data.
4. Select Roaming.
5. Select Adobe.
6. Select Adobe PDF.
7. Select Settings.
8. Choose a file name such as “Accessible.”
9. Save these settings.
10. Then in the MS Word Acrobat tab select Create PDF. See screen shot below.
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[bookmark: _Toc14263210][bookmark: _Toc14263264][bookmark: _Toc14272070]
[bookmark: _Toc14272071]Document Properties in Adobe Acrobat Pro
Fonts
It is possible to check whether fonts are embedded in the PDF using the Fonts tab in the File > Properties menu in Adobe Acrobat Pro. In this Fonts tab, beside the names of the fonts found in the document, it should read embedded or embedded subset. The encoding information listed under the font may vary, but this is not an issue unless it is left blank (has no information beside the word “Encoding”) or reads “Unknown”. 
[image: ]
It is best to embed fonts during the conversion process, as described above. However, when this is not possible, fonts can be embedded using PDF software. However, embedding fonts using Adobe Pro, for example, should be done only when necessary, because sometimes fonts cannot be embedded using this method and when this is the case a return to the source document is likely necessary. Thus, font embedding should be completed and checked as one of the initial steps in the accessible PDF creation process. 
Fonts can be embedded in Adobe Pro using the Print Production Tool and once this is opened, follow these steps:
1. Select the Pre-flight option
2. In the window that opens, click the image of the blue wrench. 
3. From the list that appears, select Embed missing fonts.
4. Click the Fix button on the bottom right side of the window. 
After completing the above steps, there will be a prompt to save the document and then, if successful, a green checkmark will appear to indicate that fonts were embedded. A dialog box will indicate if the process was unsuccessful. See screen shot. 
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[bookmark: Language]Language 
The overall language of a document needs to be set in the File > Properties menu in the Advanced tab. This assists a screen reader in knowing how to read a document. If the language of the document is not available in the drop-down menu then the ISO (two-letter) language code can be typed into the box. There is a means of identifying variations in language within the document if, for example, there is a French or Latin expression in an English language document. This can be done through changing the language of content within tag structures and this process is discussed in more detail in the Setting the Language of a Paragraph or Phrase section of this document. Fully bilingual documents should be divided into separate documents. 
Initial View
The Initial View tab, within the File > Properties menu allows the document creator to set how a PDF will initially open for a user. There are several options that can be selected in the layout and magnification section of this tab to aid accessibility.
Layout and Magnification section:
· Navigation Tab = Bookmark Panel and Page.
· Page Layout = Single Page Continuous.
· Magnification = Fit Width. 
 Window Options:
· Show = Document Title.
All the options under User Interface Options should be left unchecked because the document creator does not want to hide controls or options from the user.
 See screen shot below. [image: ] 
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[bookmark: _Toc14272073]Tags 
Screen Readers use tags to interpret the document.
What are tags? 
Tags are a layer on top of the document that allow a screen reader to read aloud the content on the page. The concept of this type of mark-up is similar to that used in HTML or Styles in an MS Word document in that it exists as a document layer. 
Tags correspond to the type of content that they represent. For example, text in a paragraph will be marked with a <P> tag. Relevant images (i.e. those that are not decorative) will be marked with a figure tag, <Figure>. The following is a list of common tags: 
Common Tags
· <Document> tags: Are the first tags in documents with other tags nested within these tags. 
· <Artifact> tags: Are for content that does not need to be read by a screen reader such as decorative images. 
· <P> tags: Are used for text content such as paragraphs. 
· <H1> - <H6> tags: Represent various heading levels in the document. As in other document types, start with H1 and avoid using more than six heading levels.
· <Figure> tags: Are for images. Alternative text also needs to be added to these images. 
· <L> tags: are for lists and all components of a list are nested in this tag including:
· <LI> tags: include a list label and list body nested within. 
· <Lbl> tags: Are list labels such as the bullet or number part of the list. 
· <LBody> tags: Are the list body, which is the text content of the list. 
· <Table> tags:  Contain all tags that are part of a table including:
· <TR> tags: Are used to identify table rows and contains, as nested tags, table header and table data tags. 
· <TH> tags: Represent table headers, which identify header cells of tables. Header rows and columns need to be identified with a <TH>. 
· <TD> tags: Are for table data cells. All non-<TH> cells in a table are <TD> cells. 
Tags including Parts <Part>, Divisions <Div>, Articles <Art> and Sections <Sect> are container tags and are not read by screen readers. They are often used help organize a document into parts or sections for ease of reference by the document creator. 
Please see the full list of tags that are supported in Adobe Acrobat (URL: https://helpx.adobe.com/acrobat/using/editing-document-structure-content-tags.html). 
Tags Panel 
Most of the work for creating and remediating tags can be done in the Tags Panel. The Tags Panel can be accessed through the collapsible menu on the left side. Clicking in the gray space of the menu (e.g. not on a specific element) will present a menu where panels such as the Tags Panel can be added, if they are not visible in the left side menu when first opened. See screen shot of Tags Panel. 
[image: ]
Autotag
The capacity to Autotag the document is useful when tagging cannot be generated during the conversion process to PDF such as when the source document is not available. 
The Autotag feature is found in the Accessibility Tool and will generate a list of tags based on content of the document. This is not a perfect process, however and a human evaluation needs to be done to ensure that tags are correctly identified (i.e. a heading 2 is tagged as a heading 2) and that tags are in the correct reading order. 
Manual Tagging 
There may be times when the document creator needs to create a tag manually such as when there is a need to add a tag to content that has not been tagged through the Autotag process. 
It is possible to edit tags by performing a right mouse click when on a specific tag to make the text within the tag editable. Thus, the tag can be changed by changing the text to the appropriate tag name; for example, changing <TD> to <TH>. 
Creating a new tag for text:
1. Place the mouse on the tag above where you want the new tag to be created. The new tag will appear below the tag that the mouse has highlighted. 
2. Right click on the mouse and select the New Tag option. 
3. Select the type of tag needed from the drop-down menu or type the name of the tag. There is now an empty tag that needs contents. The Title option can be left blank. Data in the Title field is not read by a screen reader.
4. Right click on the empty tag so that the tag name is highlighted (i.e. in blue or gray depending on the software version).
5.  Immediately move to the page and select the text to be in the tag. This is done by selecting the text with the mouse as would be done to highlight text in a word processing document. 
6. Once the text is highlighted move back to the highlighted tag and right click with the mouse. 
7. Select Create Tag from Selection. The text will appear in the tag beside a box icon. 
Tagging an Image 
When creating a new <Figure> tag for an image, follow the same procedure as described in creating a new tag for text; however, instead of highlighting content on the page and taking it to the tag, find the image in the Content Panel and then move back to the Tags Panel and select Create Tag from Selection. 
Artifact Tags
Tags are required for all content including text, images, tables etc. to avoid the screen reader conveying information as “untagged content,” which can be confusing for users. However, there may be content that can be ignored by screen reader. A key example of this is decorative images that appear on a page because these are not relevant to document context. Other examples may include page numbers and background content. When an image is present on the page but does not need to be read by a screen reader the content should be tagged as an artifact with the <Artifact> tag. Content that is tagged as an artifact will still exist in the Content Panel. It is best to artifact content that is not relevant; it should not be deleted. Empty tags can be deleted. 
Page header and footers provide important navigational information for visual users of a document. In a PDF, header and footer content should have an <Artifact> tag, so that it is not read repeatedly by a screen reader. 
To Delete or Artifact?
· Avoid deleting content containers as indicated below in Figure 1:
[image: ]
Figure 1: Content Container in PDF Tags
·  Empty tags can be deleted. For example, after content has been tagged as an <Artifact>.  
· A tag is empty when it does not have a “+” sign, as illustrated below in Figure 2: 
[image: ]
Figure 2: Empty Figure Tag in PDF Document
Tagging a List
There are a number of list tags that work together to create a tagged list. These include: 
· <L> tags: Are for lists and all components of a list are nested in this tag including:
· <LI> tags:  Are for list items and include a list label and list body nested within. 
· <Lbl> tags: Are list labels such as the bullet or number part of the list. 
· <LBody> tags: Are the list body, which is the text content of the list.
Note: List labels <Lbl> are not a requirement, but they are useful for providing additional information to the screen reader user. See the diagram below for the component tags of a list. See diagram of a list tag structure below. 

Sub- lists
It is possible to create properly tagged lists with sub-lists. This essentially takes the form of a tagged list inside of a tagged list. 
Tagging a Table
Like lists, there are a number of different tags that make up a properly tagged table. These include: 
· <Table> tags: Contain all tags that are part of a table including:
· <TR> tags: Are used to identify table rows and contain nested tags for table header and table data cells. 
· <TH> tags: Identify table header cells. Both header row and column cells need to be identified with a <TH>. 
· <TD> tags: Are for table data cells. All non-<TH> cells in a table are tagged as table data cells.
To edit a table use the Table Editor that can be found through the Accessibility Tool. 
· In the Accessibility Tool, select the Reading Order option. 
· Use the selection tool to select the table. See screen shot. 
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· When the table is highlighted, right mouse click on the table.
·  Select Table Cell Properties from the options that appear. 
The window that appears will have options to set the type and scope of cells, as indicated in the screen shot below. 
[image: ]
Table header and table data cells can be edited in this Table Cell Properties window or by editing tags within the Tags Panel, for example changing a <TH> tag to a <TD> tag. However, the scope must be set for header cells within the Table Cell Properties window. This means identifying from the Scope drop-down menu if header cells are row headers, column headers or both. 
Table Remediation
· If information from one cell was split into two cells, correct this by dragging content from one tag to another within the Tags Panel. This is done like any “drag and drop” with the mouse. Then delete the empty table data or header tags that are not needed. 
· If cells are merged incorrectly then this can be fixed by changing the span attributes within the Table Cell Properties window of the Table Editor. For example, if a column should span two rows, change “Column Span” to “2”, as seen in the screen shot below. 
[image: ]
· Irregularity occurs when there are not the same number of columns in each row. This is a warning within the Acrobat Accessibility Checker. Within a PDF it is ok to have merged cells in a table when they are identified correctly. Within word processing applications, like MS Word, there is no mechanism for correctly identifying merged cells in a table. 
Role – Mapping 
Role Mapping is a dictionary for the PDF. 
Role mapping allows tags not support by Adobe to be understood as tags that are supported.  For example, in the screen shot below, the tag “Diagram” is not a supported tag in Adobe so it has been mapped to, or will be read as a “Figure” tag. 
[image: ]
· If there is a Role Mapping error in the Accessibility Checker, look to see that all tags are being “mapped” to tag types that are supported by Adobe. 
· Changing role-mapping elements is one method for allowing tagged elements to be changed, without editing individual tags in the Tags Panel. 
[bookmark: SettingLang][bookmark: _Toc14272074]Please see the full list of tags that are supported in Adobe Acrobat. (URL:https://helpx.adobe.com/acrobat/using/editing-document-structure-content-tags.html).

Setting the Language of a Paragraph or Phrase
[bookmark: DocumentProperties]It is important to set the main language of a document in the Advanced Tab of the Document Properties window. Please see the Document Properties section of this guide. Often, however, documents may have single phrases or short paragraphs in a language other than the main language of the document. To ensure that a screen reader correctly interprets this change in language it is important to set the specific language of this content. This can be done in the Tag Panel. 
To identify the language of a specific tag complete the following steps:
1. Select the tag.
2. Right click on the tag and in the menu select Properties.
3. Enter the language name or ISO language code in the Language field of the Object Properties window. 
See a screen shot of Object Properties window.
[bookmark: _Toc14272075][image: ]

Links
 Create links in source document when possible. 
The simplest method of ensuring accessibility of links in a PDF document is to create them in the source document and ensure that they are properly converted when creating a PDF. However, links can be created in Adobe Acrobat Pro. 
To create a link in Adobe Acrobat Pro follow these steps: 
1. Highlight the text with the selection tool.
2. Right mouse click on highlighted text. 
3. Select Create Link.
4. In the Create Link window select the following properties: 
a. Link Type = Invisible Rectangle 
b. Highlight Style = Invert
5. In the Tags Panel, ensure that a <Link> tag has been created with both the relevant text and link object (indicated as Link - OBJR). 
Note: A link tag should be nested within another relevant tag such as a <P> tag which contains surrounding paragraph text, for example. See below the screen shot of the Create Link window below.
[image: ]
Descriptive Links
Screen reader users often search by hyperlinks, so it is important to make sure these links make sense without their surrounding content. Links are more accessible when the link text briefly describes the destination. Avoid non-descriptive link phrases such as “here”, “click here”, “read more” or “learn more”. 
Provide the full URL for links
Documents with the potential to be printed should include the full URL in a footnote, appendix or in brackets after the live link. The standard visual representation for a link is:
· Underlined text.
· Blue for a link not visited (HEX #0000FF, RGB 0-0-255).
· Purple for a visited link (HEX #800080, RGB 128-0-128).
Sample:
Refer to the CNIB Clear Print Guidelines
(URL: https://cnib.ca/sites/default/files/2018-07/CNIB%20Clear%20Print%20Guide.pdf)
Do not use: Click here for the CNIB Clear Print Guidelines.
[bookmark: _Toc14272076]
Bookmarks 
Bookmarks are an important navigation tool.
Documents with two or more pages should have bookmarks. If a document is only one page, but has headings it may also be valuable to create bookmarks.
Bookmarks are often created during the conversion from a source document, but like tags should be evaluated to ensure proper order and nesting. For example, a heading 2, should come under a heading 1 bookmark. This is done by drag and drop within the Bookmarks Panel. Bookmarks can also be created in this panel. When there is already a proper tag structure in place, bookmarks can be easily created from this existing structure. 
To create bookmarks from the tag structure:
1. Select the Options button from the menu within the Bookmarks Panel. 
2. Select New Bookmarks from Structure from the menu. 
3. In the Structure Elements window select which element(s) to use for bookmarks. For example, it is possible to select a number of heading levels (i.e. heading 1 and heading 2’s etc.). See screen shot of Bookmarks Panel.
[image: ]

[bookmark: _Toc14272077]Tab Order
Tab order is important for keyboard navigation. 
When someone is using the keyboard to move/read through a document the order by which the Tab key moves them through the document is important. Tab order should be the same as the reading order. 
Tab order can be set using existing tag structure, thus it should be one of the final steps in creating an accessible PDF.  
Tab order is set in the Thumbnails Panel. In this panel, the document pages will be visible. To set the tab order: 
1. Select all the pages (ctrl+A). 
2. Right mouse click on the first page and select Page Properties. 
3. In the Page Properties window select Use Document Structure. See screen shot.
[image: ]
Page Numbers
Consistent page numbering is important. 
Page numbers as displayed in the Thumbnails Panel should be consistent with page numbering displayed in the main navigation bar. To correct any inconsistencies follow these steps:
1. In the Thumbnails Panel, select pages to be corrected.
2. Right mouse click on a selected page. 
3. Choose Page Labels from the menu. 
4. In the Page Labels widow correct any errors using the Numbering section. 
[bookmark: _Toc4401571][bookmark: _Toc5607700][bookmark: _Toc5692611][bookmark: _Toc14263273][bookmark: _Toc14272078]
[bookmark: _Toc14272079]Scanned Documents
Perform Optical Character Recognition (OCR) on scanned documents. 
Scanned PDF documents should be avoided where possible because, as images of text, they are inaccessible to assistive technologies. This means that documents cannot be read aloud, resized or altered etc. Optical character recognition does improve accessibility by allowing text to be recognized as such; however, generally some errors occur through this process. It is preferable, where possible, to instead start from a software that can create the document more accessibly. 
For more information on the OCR process visit Adobe’s scanned PDF documents page.

[bookmark: _Toc14272080]PDF Form Accessibility
Tagging Form Fields 
Tag form fields using the Autotag Form Fields option in the Accessibility Tool.  Form field tags, <Form>, are nested within other tags such as a paragraph, <P>, tag which also contains the text (label) that is associated with form field. See screen shot. 
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Labels 
Labels, such as the text associated with the form field should also indicate when a field is required and/or what is required by a particular field. For example, having text that indicates, “Name (required)”, is one way of ensuring that users know how to use the form field. Also, if the question uses a number of check boxes where multiple selections can be made, it is useful to have “(select all that apply)” text associated with the form elements. 


Tooltips and Required Fields
Tooltips are read by screen readers and are comparable to alternative text when completing forms. 
Set the Tooltip by completing the following steps:
1. Select the Prepare Forms Tool.
2. Right mouse click when the mouse is on the form field. 
3. Select the Properties option from the menu.
4. Enter information in the Tooltip field. 
Place information in the tooltip about what is required in the specific form field. 
When the form elements are check boxes, the tooltip should include the question and the choice for the check box, as well as any requirements such as “select all that apply”. This should be done for all check boxes in a series.
When the form elements are a set of radio buttons, the question, as well as any requirements should be indicated in the tooltip; however, there is no need to include individual choices because radio buttons are identified as a set, whereas check boxes are identified as individual elements. 
Required fields can be indicated in the Text Field Properties box. When this Required box is checked and a form element is not completed by the user, a dialog box with an error message appears. Similarly when the form creator selects a specific format for a field such as format for entry of a date and the user does not enter information correctly an error message will appear. This is an important part of accessibility, as it allows the user to clearly know when errors have occurred with form completion. Custom error messages can be created using JavaScript entered into the Text Field Properties window in the Validate tab. 
Electronic Submission 
Forms intended for submission should have a submit button. Buttons can be created in the Prepare Forms Tool. 
In terms of accessibility, any buttons created should have the following properties: 
In the General tab of the Button Properties window enter:
1. Relevant text in the Name field 
2. A tooltip.
In the Options tab of the Button Properties window ensure the following:
Layout = Label Only 
Behavior = Invert
Label: Has text that indicates name of the button. See the screen shot of the Options tab in Button Properties window. 
[image: ]
In the Actions tab of the Button Properties window ensure the following: 
Select Trigger = Mouse Up. 
Selection Action: Select the action the button is to perform (i.e. Submit or Clear). 
Function Tips
· Test the tab order. Use the Tab key to jump from field to field.
· Test radio buttons and check boxes.
· Test all fields for font family, size and colour.
· Test all fields for text alignment and wrapping.
· Review and repair document tags as needed.
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[bookmark: _Toc14272081]Accessibility Checker
Use the accessibility checker tool to find and repair accessibility issues. The Acrobat Check Accessibility Tool inspects a document for accessibility issues and highlights where a human evaluation is needed to check for accessibility. 
To check the accessibility of a document choose the Accessibility Tool and select Full Check. 
The checker explains why and how to fix the issue. Some issues can be fixed right from the Accessibility Checker by using the mouse to right click on the listed error and selecting Fix from the menu.  
Note: Using the Acrobat Accessibility Checker does not guarantee a pass on all of the criteria listed in the PDF Techniques for WCAG 2.0 document. 
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[bookmark: _Toc14272082]Further Information on Accessible Documents
Trent-specific workshops and resources 
 [URL: https://www.trentu.ca/humanresources/staff-development-schedule]
LinkedIn Learning training can be accessed through the MyTrent Portal.

[bookmark: _Toc14272083]Contact Information
Trent’s Centre for Human Rights, Equity and Accessibility 
(URL: https://www.trentu.ca/chrea)
Phone: (705) 748-1011 extension 6602 Email: access@trentu.ca
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